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Preparing your Mac
When upgrading the operating system, no matter your platform of 
choice, it's always a great idea to not go into it blindly. Be prepared, and 
more importantly, make sure you computer is prepared. Some of the 
prep is stuff you should be doing anyway, so make sure to give it a read 
if you are yet to upgrade.
How to prepare your Mac for Mountain Lion
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1. Back up
Backing up before applying any software update or upgrade is always 
recommended, and given the ease of doing so with the availability of 
Time Machine and system cloning tools, there is almost no reason to 
not have a good backup routine going. If you use Time Machine or 
another regularly scheduled backup tool, then you should be good to 
go. If you do not regularly back up, then be sure to attach your backup 
drive and run your backup routine before installing Mountain Lion.

2. Check for current problems
Current problems with your system can sometimes transfer odd 
behaviors to the new OS installation. It might be best to first tackle 
these, especially if you can't use aspects of your system such as not 
being able to authenticate yourself as an administrator, or if you are 
experiencing persistent crashes. For more minor issues such as 
slowdowns, you can run a basic maintenance routine by booting into 
Safe Mode (hold Shift at startup), and then using Disk Utility to check 
the hard drive for errors and fix permissions on the boot drive.

3. Wait a few weeks
Whenever a new OS is released, there is a lot of hype around it and 
people jump on board as soon as they can; however, it is not 
necessary to do this. Often it is beneficial to wait a short while and see 
if any outstanding bugs are being experienced by users. Generally, 
Apple releases a quick update or two following a major OS release, 
which address some known bugs that either could not be fixed before 
the final release or which only became known after the release.

4. Prepare to back up the installer
Starting with OS X Lion, Apple is no longer releasing the OS on DVD 
media. While the installation process through the App Store will 
download all the needed files in a disk image, it will remove these files 
after the OS is installed. While the OS will still be available through the 
App Store if needed, it may be useful to back up the OS X installer 
before performing the upgrade, which can be done either by copying 
the installer to another drive or by accessing the embedded disk image 
and burning it to DVD or restoring it to a secondary USB or FireWire 
drive. The instructions for doing this should be the same as that for OS 
X Lion.



Get started with Notification Center
Mountain Lion has borrowed a lot of features from iOS, including 
Notification Center. With OS X now having one convenient place for 
organizing notifications on your computer, you'll more than likely end up 
using it to some extent. It's best you know what it does and how to 
customize it.
Getting started with Mountain Lion's Notification Center

 (Credit: Apple Inc. )

Mountain Lion has pounced into the Mac App Store. If you haven't already upgraded to the latest version 
of OS X, you'll want to make sure your Mac is ready for the upgrade.
Once you have gone through the preparation and installation of Mountain Lion, you're not going to want 
to wait to dig right in and get all of the new features set up.
One of the (many) features OS X has incorporated from iOS in Mountain Lion is the Notification 
Center. If you use an iOS device, you're already familiar with how it works to an extent. You can drag it 
down from the top of your screen at any time to reveal any pending notifications.
The same principle applies to Notification Center on OS X 10.8, except, you don't pull down from the top 
of the screen. The Notification Center is hidden under the right side of your desktop. There are two 
methods for you to use to reveal your notifications.

• You can click on the Notification Center icon at the far right of your menu bar.
• You can two-finger swipe from the right edge of your trackpad.
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To access Notification with gestures on a trackpad, make sure to enable it in System Preferences.

The second method will have to be enabled in System Preferences under the Trackpad option. I wasn't 
able to find any settings or options for those using the Magic Mouse and not a trackpad.

Your Notification Center settings can be found in System Preferences under Notifications.

Settings for the Notification Center can be found in System Preferences under the Notifications option.
When you open the Notifications option, you'll see a list of apps integrated with Notification Center, much 
like you do on iOS in the Notification Settings.



 

You can then select the type of alert each app will use, whether or not the app will show up in 
Notification Center, the amount of history to display, and if you want a sound or badge icon to be used 
when a new notification comes in.
You can reorder the list of apps in the settings and set Notification Center to sort manually if you want 
certain apps to always remain on top. Or, you can choose to let the notifications be displayed in order of 
last received.

On the left, an example of a Banner notifications. On the right, an example of the Alerts notifications.

There are two alert types to choose from in Notification Center. The first, Banners, will display a 
notification in the top right of your screen for a few seconds before it slides off into Notification Center. 
The second, Alerts, requires you take an action on the alert before it will go away.
One feature that iOS currently doesn't have in Notification Center, that OS X does, is a do not disturb-
like setting. If you're watching a movie, or need to get some work done without the distraction of 
notifications popping in all the time, you can temporarily turn off alerts and banners.



 (Credit: Screenshot by Jason Cipriani/CNET)

To access the feature, open Notification Center and scroll down using two fingers until a toggle switch is 
pulled down from the top. You won't receive any further alerts from Notification Center until you either 
turn them back on, or the following day, whichever occurs first.
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With Twitter integration now throughout OS X Mountain Lion, you will also see a Click to Tweet button in 
Notification Center after you have added a Twitter account in System Preferences > Mail, Contacts & 
Calendar. Clicking on the button will allow you to compose a tweet directly from the Notification Center.

Growl and Notification Center
Since we are on the topic of Notification Center, we should probably talk 
about the popular OS X notification platform Growl. If you're interested 
in integrating your Growl alerts into Notification Center, this post is 
made for you.
How to integrate Growl with Notification Center

 
OS X Mountain Lion brings the familiar iOS Notification Center to the Mac. Getting notifications on a Mac from installed 
apps is nothing new to OS X. Users of the popular app, Growl, have been receiving notifications from their favorite apps for a 
long time. Now they're faced with a decision to manage notifications in two places, or choose one notification system over the 
other. Or are they?
Instead of managing alerts in both Notification Center and Growl, you can integrate Growl into Notification Center by 
installing a simple app called Hiss.
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Hiss, currently in beta, is free to use and takes only a few seconds to set up. Once setup is complete, all of your Growl 
notifications will show up in Notification Center.

• Download Hiss from the developer's Web site.
• Drag the app to your Applications folder.
• If you have Gatekeeper enabled, you will see a dialog telling you the app can't be installed. You 

can bypass this on an app-by-app basis by right-clicking the app and selecting Open. It's a good 
idea to only bypass Gatekeeper with apps and developers you trust.
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AirPlay mirroring
Another big feature brought from iOS to OS X is AirPlay. If you have a 
compatible Mac, you can now mirror your Mac's display to your TV 
through an Apple TV. For a video demonstration, check out this post.
How to use AirPlay Mirroring in Mountain Lion

If you've managed to get your hands on Mountain Lion for Mac, there's a really cool feature called AirPlay 
Mirroring where you can show your desktop and more on a big screen hooked up to an Apple TV. AirPlay 
Mirroring is something you might use when you want to show your work at a meeting, show your photos to your 
family, watch video, and so on, but on an Apple TV-connected big screen. Here's how to do it.
Editors' note:Unfortunately, AirPlay Mirroring only works on Macs made in 2011 or later. For those on older 
machines running Snow Leopard, try AirParrot.
You start by making sure your computer is on the same network as your Apple TV, then look for the monitor-
shaped icon in your Menu bar -- Mountain Lion automatically detects when an Apple TV is in range. To start 
AirPlay Mirroring, select Apple TV from the AirPlay drop-down menu.
The first thing you'll probably notice is there is a little bit of lag between your laptop and the TV, but you can open 
windows, move files around, or whatever you want, and you can see it all on the big screen.

Under the AirPlay icon, simply choose Apple TV.

With your desktop on the big screen, there are several ways you can take advantage of the larger viewing area. If 
you have photos on your Mac, AirPlay Mirroring is the best way to display them to a roomful of people. Simply 
launch iPhoto or whatever photo management program you prefer, switch to full screen on your Mac, and flip 
through full-size images or start a slideshow.
Next, you can try checking out video. Obviously, with Apple TV you already have connections to YouTube and 
Netflix, so there's not much point in mirroring those services on your big screen. The major advantage of AirPlay 
Mirroring in Mountain Lion is that you can show Flash movies -- something iPhones and iPads with iOS 5, which 
also have AirPlay Mirroring, cannot do. To check out a movie, pick your favorite Flash-based media site, such as 
Hulu, Comedy Central, or a major network TV site. Once you've decided on a TV episode or movie, switch it to 
full screen and enjoy the show. This feature will be particularly useful for those who don't have a traditional cable 
service and will open up a whole new library of TV and movies to watch.

AirPlay Mirroring not working properly? Try these fixes.
I've heard about some people encountering problems with audio transferring to a big-screen TV, but it's usually a 
pretty easy fix.
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Obviously you'll want to make sure the audio volume is up on both devices. But if you're still having trouble, go to 
the Apple menu to open System Preferences, choose Sound, then under the Output tab make sure Apple TV is 
selected. Close the window, try it again, and you should be able to hear audio coming from your TV's sound system 
no matter what you're showing.

In the Displays settings choose "Best for AirPlay."

If it's the picture giving you problems, there are a couple of ways to make it look better. If you're noticing black 
bars on the top and bottom or on all sides, try going to System Preferences, then choose Displays. Now, click the 
radio button that says "Best for AirPlay." This should make the picture fit the larger screen size and aspect ratio of 
your big-screen TV.

In the Displays settings at the bottom, you can toggle Overscan correction.
(Credit: Screenshot by Jason Parker/CNET)
If you're noticing that you don't seem to be able to view the full area of the movie or show you're watching, click 
the AirPlay button in your Menu bar (the monitor-shaped icon), select Displays (you can also get there via the 
System Preferences), than uncheck Overscan. It's wise to try it both ways to see which way looks better to you.
AirPlay Mirroring is one of the best new features in Mountain Lion, for conducting meetings, showing your photos 
to a room, and especially for the number of new TV and movie possibilities. Hopefully with these tips you can get 
your AirPlay Mirroring working so you can enjoy your desktop on the big screen.

AirPlay-only audio
If mirroring your display isn't something you want to take advantage of, 
but you want to stream the audio from your Mac through your TV, you 
can do it with a few clicks of the mouse.
AirPlay only the audio from your Mac using OS X Mountain Lion

One of the new features in OS X Mountain Lion is the new AirPlay Mirroring feature. 
AirPlay Mirroring makes it easy to give presentations, watch Flash videos (Hulu, 
anyone?) or show off photos from your recent vacation on a TV. If you want to see 
AirPlay Mirroring on OS X in action, make sure to check out Jason Parker's video 
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demonstration.
One thing that isn't really advertised about the new AirPlay feature on your Mac is the 
capability to send only the audio from your Mac to any AirPlay compatible device. 
Meaning, you don't have to mirror your entire display to get the sound from your Mac to 
your Apple TV.

Sure, you have been able to stream music from iTunes to your Apple TV for some time 
now, but what about streaming music from other sources such as Spotify or Slacker? With 
OS X Mountain Lion, a Mac built in mid-2011 or later, and an AirPlay compatible device, 
it's now possible.
Remember, you'll need an Apple TV (or AirPlay compatible speaker) connected to the 
same network as your Mac for this to work.
In order to stream all audio from your Mac using AirPlay, you simply need to change the 
audio output of your Mac. You can do this one of two ways:

1.

 
2. The first is by launching System Preferences > Sound > Output and 
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select Apple TV.

3.  
4. The easier method is to hold down the Option key on your keyboard, 

then click on the speaker icon in your menu bar. You will then see a list 
of audio output devices, including your Apple TV.

Once you change the audio output to the Apple TV, all audio coming from your Mac will 
go through the Apple TV, and not the internal speakers on your Mac.
To change the audio output back to your Mac's internal speakers, you can either Option-
click on the speaker icon again and select internal speakers, or you can go back into 
System Preferences and change it there.



Dictation
Using dictation to type out a quick response in Messages, a blog post, 
or even a lengthy e-mail can save your fingers from pounding away on 
the keyboard. Using dictation on Mountain Lion is simple, with almost 
no setup required. Just make sure you have an Internet connection.
How to enable dictation on OS X Mountain Lion

The latest edition of Mac OS X, OS X 10.8 Mountain Lion, is packed full of new features, over 200 in all. One of 
them is a built-in dictation service, similar to the dictation feature found on the iPhone 4S.
By default, dictation isn't enabled after installing Mountain Lion on your Mac. If you want to use it, you're going to 
have to enable it. 
The default shortcut to start dictation on your Mac is pressing the Function (Fn) key twice. The first time you try to 
start dictation, you'll be prompted to enable it.
As pointed out by a reader after this story was published, not all keyboards will have a Fn key. If that's the case 
with your keyboard, you can set the shortcut key in Dictation & Speech settings found in System Preferences.

 
Click on OK.

 

You're reminded one last time that anything you say while dictation is being used will be sent to Apple's servers. 
Click Enable Dictation to proceed. 
Now that it's active, you can press the Fn key twice, in any text field, and begin speaking. Once you are done, 
you're required to either click Done on the dictation icon, or press the Fn key once. Otherwise, dictation will stay 
active listening for more input. You'll see three dots animate while your text is transcribed and then placed in the 
text field.
Keep in mind, Dictation will not place any punctuation (or correct your grammar) in the text it transcribes. If you 
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want a comma, exclamation point, or period in your text, you have to speak it. For example, saying "This is me 
talking period" will be dictated as:

 

If you want to disable dictation, or change the keyboard shortcut to activate it, you can change it by going to 
Dictation & Speech in System Preferences.

Preview open tabs in Safari
Safari 6 was released alongside Mountain Lion, bringing a slew of new 
features to Apple's beloved browser. One of them is the ability to quickly 
preview all of the open tabs in your browser window. This is another 
feature that's similar to what's found on iOS. It works well and comes in 
handy if you're in the habit of leaving a lot of tabs open.
Preview all tabs with Safari in Mountain Lion

In past versions of Safari, you had to navigate to a new tab to view its contents; however, with Safari 6 in 
Mountain Lion, Apple has added a new feature that allows you to preview all of the open tabs in a 
window.
When you create tabs in the browser either by clicking the plus button to the right of the toolbar or by 
pressing Command-T, you will now see a button appear next to the plus that looks like a small rectangle 
with margins. Clicking this (or selecting "Show All Tabs" in the View menu) will shrink the tabs' content 
slightly, displaying them side by side on a gray, textured background.

This button will appear when you have multiple tabs in a window, which will allow you to preview them all.

The current tab will be shown in the middle of the window with its title, URL, and content centralized, and 
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the screen will show an edge of the adjacent tabs to the left or right of it. At the bottom of the screen you 
will see a series of dots that represent the number of available tabs, with the current one highlighted.
This new feature adds to the previous tab navigation options, which were directly clicking a tab or using 
the Shift-Command-Bracket hot-key combination for switching between them. With the new preview 
feature, you can scroll to the left or right using gestures or the arrow keys, or you can click the dots at 
the bottom of the window to go to their respective tabs.
While useful for previewing your various tabs, this view is not intended to be a full tab management 
system. You can close unwanted tabs by clicking the X in the tab's title; however, this is the extent of the 
management you can do from this view. There are no options for organizing the tabs, and you can't copy 
the tab's URL or otherwise interact with its contents.

Bring back Web sharing
It's possible to bring back Web sharing, a feature that went missing in 
Mountain Lion, with a little work. If you're comfortable with Terminal, 
you'll feel right at home enabling Web sharing on Mountain Lion. If you 
aren't comfortable with Terminal, Topher Kessler does a great job laying 
out the required steps in a simple manner.
How to enable Web Sharing in OS X Mountain Lion

The Sharing services in OS X allow for a number of connectivity options, including screen 
sharing, file sharing, printer sharing, and the capability to use your computer as an Internet 
router. In past versions of OS X, Apple has also included a full Web sharing service using the 
open-source Apache server that allows you to host Web pages on your computer, but this 
option has been removed from the system preferences in Mountain Lion.
Despite its relative lack of popularity, the presence of the full Apache Web server in OS X has 
been useful for testing Web development projects, or setting up a small workgroup Web server.

The Web Sharing feature in OS X is missing from Mountain Lion's Sharing system preferences.

While Apple may have removed the configuration settings for the Web server in the system 
preferences, the Apache server is still included in Mountain Lion and can be enabled for those 
who need it. The steps for enabling this include optionally configuring the server for hosting 
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Web pages in the "Sites" folder in your home directory, and then enabling the server itself.
Optionally enable user Web sites
By default the Apache Web server will issue Web sites that are stored in your system's global 
Web server folder (/Library/Web Server/Documents), which are accessed by typing "http://
localhost/" in a Web browser. However, if you try to access Web sites in your personal sharing 
folder by appending "~username" to the end of the URL then you will get "Forbidden" error in 
the Web browser. While you can use the global Web server folder for your sites, for 
convenience you can enable your home folder's site by creating an Apache user configuration 
file like the one created in prior versions of OS X when personal file sharing is enabled:

1. Open the OS X Terminal utility (/Applicaitions/Utilities/)
2. Create and edit an Apache user configuration file named after your user account by 

running the following command.
sudo pico /etc/apache2/users/`whoami`.conf

3. Copy the following text into the Terminal editor that opens, but be sure to change the 
"username" text to the short name of your user account:
<Directory "/Users/username/Sites/">
!!!!!Options Indexes MultiViews
!!!!!AllowOverride All
!!!!!Order allow,deny
!!!!!Allow from all
</Directory>

4. Save and close the editor by pressing Control-O followed by Control-X.
After this action is performed, create a folder called "Sites" in your home directory if it is not 
already present, and then place your Web pages within it.
Enabling the server
To enable the Web server you have two options. The first is to temporarily start it using the 
following "apachectl" terminal command (to disable the server, repeat the command with "stop" 
instead of "start"):

sudo apachectl start

When you enable the Web server you will see this warning appear, so be sure to allow connections if you plan on serving pages 
to other computers.

Note that since Web sharing is not in the Sharing system preferences, it is no longer considered 
an essential system service so the OS will not automatically configure the firewall for it. 
Therefore when you enable it, you will be asked to allow the Web server process (httpd) to 
allow incoming connections. If you plan on using the server as a test server for your computer, 
only then do you not need to allow connections through the firewall; however, if you want to host 
pages for other computers to see, then you will need to allow connections.
Keep in mind that the steps so far will only keep the server running while the system is booted, 
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so if you restart then the server will be disabled again. To enable the server even after 
subsequent reboots, then you will need to enable the launch daemon for the server, which can 
be done with the following command:

sudo defaults write /System/Library/LaunchDaemons/org.apache.httpd Disabled -bool false

As with the previous command, this one can be reversed by repeating it but changing the 
"false" text to "true."
This procedure will enable the server and allow you to host Web pages, but will not enable any 
additional Web technologies like SQL or PHP. If you need these, then they can be installed and 
enabled separately following the instructions in the guide by Coolest Guy Planet Tech.
After the server is running, if you still see errors when accessing Web pages in your home 
folder (ie, with the url "http://localhost/~username"), then be sure the file (and any others you 
may have configured) are properly accessible by running the following two Terminal commands 
to alter their ownership and permissions:

sudo chown root:wheel /etc/apache2/users/*
sudo chmod 644 /etc/apache2/users/*

When the configuration file's permissions have been set, run the following command to restart 
the server and load the file again before attempting your connections:

sudo apachectl restart

VIPs
We all have a shortlist of contacts whom we deem a VIP -- someone 
whose e-mails we respond to immediately. You can now mark those 
contacts as VIPs and treat them as such in Mail on Mountain Lion. You 
can even limit Notification Center to only show alerts for VIP e-mails 
and no one else.
How to use Mail's VIP list in OS X Mountain Lion

In Apple's Mail program, there are options for flagging and coloring messages that you might 
find important, but in order to automatically do so, you have to set up a special rule to identify 
the message and then perform an action on it. With the version of Mail that Apple ships in OS X 
Mountain Lion, Apple has changed this to a degree by adding a VIP list.
Unlike rules that require that you set up conditions that act on incoming messages once, the 
VIP option in Mail is a dynamic filter that provides an easy way to locate all messages from your 
contacts of choice, and in this sense is more similar to a smart mailbox than a rule. However, 
unlike smart mailboxes, the VIP list has a few extra features, including limiting Mail notifications 
to the VIP list, and allowing the creation of rules based on the VIP list.
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The VIP list will appear when you add a member to it. Members will have a star next to their names.

By default VIPs may not be enabled in Mountain Lion, especially if you have upgraded from a 
prior OS X version where the VIP feature was not available. While Apple does not advertise the 
VIP option very well, it is relatively easy to set up and manage.
To enable the VIP list, all you have to do is add a contact to it, and to do this, simply select a 
message from someone you would like to make a VIP, and then right-click the name (in bold 
text at the top of the message) and choose "Add to VIPs." You can also hover your mouse to 
the left of the name and click the star that appears. If this is your first addition to the list, then 
you will see the VIP list appear in the Mailboxes section of the sidebar.
With contacts added to the list, you can select the entire list to reveal messages from all of your 
VIPs, or select individual VIPs to only show their messages. To select a subgroup of VIPs, 
simply hold the Command key while selecting individual VIPs to add or remove them from the 
selection
Adding people to the VIP list in this manner will create a property list file called 
"VIPSenders.plist" in the username/Library/V2/MailData/ folder if it does not already exist, so if 
you have troubles with adding or removing VIP members then managing this file may be an 
option for troubleshooting this process. In most cases removing it and recreating the VIP list 
should suffice, but you might also be able to edit it for more specific troubleshooting.



You can limit the messages shown in the Notification Center to only those from your VIP contacts.

To remove VIPs from the list, you can locate a message from the VIP and click the star next to 
the name to revoke VIP status, or you can also right-click the name and choose the "Remove 
from VIPs" option. This can be done using the name in the Mail message as was done to add 
them to the list, or it can be done using the name in the VIP list itself.
The VIP list has its uses, but also has some limitations. For one it is only based on individual 
contacts and therefore cannot be applied to a group. Additionally, it cannot be applied to special 
conditions such as for messages from a contact that are sent to one Mail account and not 
another.
One tip that you might find useful with the VIP list is limiting Apple's Notification Center to only 
show e-mail messages from your VIPs. To do this, go to the General section of the Mail 
preferences and select "VIPs" from the "New Message Notifications" option.

Restore Save As
OS X Lion took away a functionality users had grown accustomed to 
over the years: Save As. There was plenty of bellyaching and 
bemoaning the missing feature throughout the OS. Enough of it, in fact, 
that Apple has brought back the feature in Mountain Lion. You'll need to 
do some setting up to get it to work, but it's back!
Apple returns Save As to Mountain Lion

Apple's introduction of Auto Save and Versions in OS X Lion was one of the more controversial 
modifications made to the operating system, partially because as part of the changes Apple 
removed with the age-old Save As command and replaced it with an unfamiliar "Duplicate" 
option. While applications such as Office that include their own document-handling routines 
maintained the Save As option, those that rely on Apple's central document-handling libraries 
lost this function.
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The inconsistency of the Save As and Duplicate features between programs confused and 
disappointed a number of OS X Lion users. Even though people could set up custom keyboard 
shortcuts to use the Duplicate feature in ways that were similar to Save As, this still required 
people to somewhat relearn their approach to using Save As.

Adding these custom shortcuts in OS X should restore the classic approaches to invoking Save As.

As a result, Apple returned the Save As function to OS X in Mountain Lion, but has done so by 
keeping it as an alternative option to the Duplicate feature. While the classic Save As keyboard 
shortcut was Shift-Command-S, or it could be accessed directly from the File menu, in Mountain 
Lion these approaches will still invoke the Duplicate feature. To invoke Save As, you access the 
Duplicate function, then hold the Option key, after which the Duplicate function will change to 
Save As.
This compromise may be acceptable to some, but it still might be confusing to others who would 
prefer that Apple fully restore the Save As feature. Luckily, for these people a solution is 
available in Apple's custom keyboard shortcuts feature, which can easily be set up with the 
following steps:

1. Create a new shortcut for Duplicate
Open the Keyboard system preferences and go to the Keyboard Shortcuts tab. In here, 
select the Application Shortcuts section and then click the plus button to create a new 
shortcut for all applications. In the menu title field type "Duplicate" and then set a shortcut 
of your choosing for this feature. I recommend either using Shift-Command-D or Option-
Shift-Command-S, but any shortcut will do.
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2.  
3. With the shortcuts enabled, both the Save As and Duplicate features should be enabled.

4. Create a new shortcut for Save As
Next create a shortcut for the Save As command, by again clicking the plus button and 
typing "Save As..." (use three periods, and not an ellipsis character), then setting the 
keyboard shortcut to Shift-Command-S.

With these steps done, you should now have a properly restored Save As shortcut for most of 
your OS X applications. In addition you should now see both the Duplicate and Save As 
functions listed together in the File menu, making them both more convenient to access. 
Unfortunately in some programs such as Pages the custom shortcuts may not be recognized; 
however, you should still be able to use the File menu for access to these functions.

Expose, I missed you
Another change in OS X Lion that upset users was in how Expose 
behaved. In Mountain Lion, you'll need to uncheck a box in system 
preferences, and the old beloved Expose feature of displaying all open 
windows, instead of just one per open program will be restored.
Restore classic Expose behavior in Mountain Lion

A new setting added to OS X in Mountain Lion restores a classic Expose behavior for viewing 
all windows on the screen.
Apple's Missions Control feature in OS X is an evolution (or perhaps devolution, depending on 
your perspective) of the Expose and Spaces feature that was introduced in OS X 10.5 Leopard. 
While options for multiple desktops are great for organizing work, in some of Apple's decisions 
with the move to Mission Control it left out some of the simple approaches to Spaces that users 
became accustomed to.
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Unchecking this option will restore the classic all-window Expose option when you enter Mission Control

One of these features is the ability to view every open window in one Expose view, regardless 
of what application it uses. This option was available in OS X 10.5 and 10.6, but with Lion and 
the introduction of Mission Control, Apple only allowed the windows of a single program to be 
presented in Expose view. Instead, the Mission Control interface showed windows for separate 
applications in groups, which was intended to offer a seemingly more intuitive approach for 
viewing all windows, but ultimately was not the same thing.
In Mountain Lion, Apple has changed this by adding an option that restores the ability to view all 
windows in Expose view. The default Expose behavior is still as it was in OS X 10.7, but if you 
go to the Mission Control system preferences you will see a new setting for grouping windows 
by application. If you uncheck this option, then invoking Expose will show all of the open 
windows when you enter Mission Control instead of clustering them in stacks.
Unfortunately there is no option to dynamically switch between this and the standard grouped 
Mission Control view, as both might be beneficial to have without requiring a settings change; 
however, this is not yet an option. If you prefer to have the Mission Control view be more 
application-centric then leave this setting enabled, but if you prefer to have it be window-centric 
then uncheck this option.

Keep it secure
You can now encrypt a disk volume with a simple click, securing your 
data with almost no effort. There are some caveats that you need to be 
aware, however, of before you dive right in.
Apple adds encryption contextual menu options to Mountain Lion

A new feature that Apple has included in Mountain Lion offers a convenient way to encrypt 
secondary volumes on your Mac, making data security far more convenient.
Recently discovered by Mac OS X Hints contributor "kirkmc," if you right-click a nonboot volume 
in the Finder, the contextual menu that appears now contains an option to encrypt the disk. 
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Selecting this will bring up a window requesting that you supply a password and a password 
hint for the drive, and upon doing this, the system will wait a short while (the length of which 
depends on the amount of data on the volume), followed by quickly unmounting and remounting 
the volume as an encrypted storage location.

Right-clicking a secondary volume will allow you to encrypt it directly from the Finder (click for larger view).
This encryption option uses Apple's CoreStorage volume management system, which is the technology 
behind its second-generation FileVault 2 that was introduced in OS X 10.7 Lion. This technology 
manages logical volumes underneath the OS, so when you encrypt a volume, the encryption can be 
performed in the background without any special steps needing to be taken with Disk Utility or other 
programs.
The encryption of secondary hard drives was possible before Mountain Lion, but this new feature in the 
OS makes it effortless to manage.
Since the encryption technology used is the same as that for FileVault, the new contextual-menu option 
for it in Mountain Lion can only be performed on nonboot volumes. If you wish to encrypt the boot 
volume, then as with Lion you will need to do so from the FileVault section of the Security & Privacy 
system preferences. This allows the system to prepare the OS X Recovery HD partition to both store the 
encryption keys and present a preboot log-in window containing the user accounts that are authorized 
for unlocking the drive.



The Finder will ask you to supply a password and a required password hint (click for larger view).

While encryption does have its benefits, do keep in mind that it also has some drawbacks. The first is 
that the drive can only be read on systems that support CoreStorage, which are Macs running either 
Lion or Mountain Lion. Another drawback is that because the volume is a managed virtual volume, disk 
management tools may only see the physical volumes that are not mounted and therefore cannot be 
accessed. Luckily, with Disk Utility you can overcome this by enabling the Debug menu in Disk Utility (in 
the program's preferences) followed by choosing Show Every Partition from this menu. After this you will 
see the logical volumes appear that you can then check for errors.
The last drawback stems directly from encryption's benefits, which are that if you cannot mount the 
volume either because you have lost your password or the drive is damaged, then you will not be able to 
recover any data from it. Therefore, if you decide to encrypt a drive and store files on it, be sure you 
have them backed up in another location.

Sync Notes with Android
The new and improved Notes app on Mountain Lion is built to be used 
with Apple's iCloud service, allowing for easy syncing between all 
iCloud-enabled devices. This guide will not only show you how to sync 
iCloud devices, but also how to sync your Android devices with the 
Notes app.
Syncing Notes from Mountain Lion Macs to iOS and Android

One of the nice things about the new Mac OS X 10.8 Mountain Lion release is that the Notes application 
makes it easy to have notes sync from your Mac to your iPhone or iPad. But what if you're an Android 
user or want your notes to flow outside the Apple ecosystem for some reason? Yes, it can be done.
I don't take a lot of notes, but I've found it handy to have some things like frequent flyer numbers jotted 
down digitally in an easy-to-locate format. As a longtime Outlook user, I've used Outlook's own notes 
feature for my occasional note-taking needs.
It was especially nice that I could sync from Outlook to my iPhone using a tethered connection. These 
days, I sync through iCloud. That's left my notes effectively trapped within Outlook, unable to flow over-
the-air to my iPhone or iPad, much less my Android phone or tablets.

Yesterday, I loaded up Mountain Lion and explored how the new Notes feature might help me get my 
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notes back in sync.
Is it @me or is something wrong?
It seemed so easy. I went to the iCloud settings on my iPhone, toggled the Notes switch to on and 
figured the sync would begin. Nope. My iPhone demanded that I create an @me address in order to turn 
on note syncing.
Annoyingly, I already had an @me address. Why wouldn't iCloud just let me enter that? No matter what I 
tried, I couldn't find a way to enter my existing address. Finally, I allowed it to create a new one for me. 
Now I have two @me addresses, but problem solved.
Next, there was the small issue of the Notes app continually crashing on my Mac. In the end, the 
solution for me seemed to be going to Settings; then "Mail, Contacts & Calendars;" then disabling Notes 
for some accounts I had listed there. I also went to Settings; then "iCloud" and enabled Notes there. The 
crashing stopped, to my relief.
Testing Notes sync
Time to play. Firing up the Notes app on my Mac, I created a note to see what would happen. Since 
Notes supports pictures and hyperlinks, I made sure to add these along with some text:

Next stop was the iCloud Web site, which immediately confused me. Where was the online Notes app 
there? I didn't see it listed alongside other applications such as Mail or Contacts:

Eventually, I went into the Mail app and realized that Notes lives there. I gather that before Mountain 
Lion, Notes was part of the Mail app (as an Outlook user, I never went into the Mac mail app). I guess it 
still makes sense for many people that Notes remains part of Mail in iCloud. But for me, using Notes as 
a separate app for the first time in Mountain Lion, I sure found it confusing that it wasn't a separate app 
in iCloud.
Anyway, success! There was my note within Mail. The picture didn't display, but it was included as an 
attachment:

I also found that the note successfully flowed to both my iPad and my iPhone. Similar to iCloud, the 
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picture didn't show:

Unlike in iCloud, clicking on the paper-clip attachment icon didn't download the image for viewing. No 
worries. My notes all tend to be text, anyway.
From Apple to Google
What's not to love? Well, I live a multiplatform life. If I'm out using my Android phone, I'd like to have 
quick access to my notes. Since my calendar can sync from my desktop to my iOS, Android, and 
Windows Phone devices, how about my notes?
It turns out to be pretty easy. If you have a Gmail account (or a Google Apps account), on your Mac, go 
to "Mail, Contacts & Calendars," add the account, and tick the "Notes" box:

After you've done that, syncing still works as it did back with iOS 4. Your notes will flow into Gmail and 
be given a "Notes" label. Click on that label, and you'll find your notes there. I made a note similar to the 
one above, and here's how it flowed into Gmail:
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The same note also flowed to my Galaxy Nexus, as it did to my iPhone and iPad.
To reach your iOS devices via Google, go to "Mail, Contacts & Calendars" in Settings on your device. 
Add your Gmail account, if it's not already there. Then move the Notes setting to on.

When you've done this, notes you make on your iOS devices or your Mac will sync between them. It's 
pretty nice, plus you'll have copies that flow one-way to Gmail.
Three limitations to consider
One-way? Yes. That's one of three big drawbacks to this method:

1. If you edit a note in Gmail, or try to create a new note there, it won't flow into the Notes app on 
your Apple devices.

2. Notes won't be "instant on" with your Android devices. You'll need a connection to load them, if 
you haven't already downloaded them.

3. Notes will not flow into iCloud.com.
These limitations are important. If you're living in an all-Apple world, there's not much sense in trying to 
sync over to Gmail, I'd say. If you live in both worlds, then this might be an option you wish to explore.
A better option is perhaps using a service like Evernote, which supports multiple devices including 
Windows Phone. You'll have to pay for offline access, however.
Another workaround would include just logging into iCloud from your Android phone and getting your 
notes that way, when needed.
Some wishes for Google, Apple, and Microsoft
What I'd really like to see is Android get its own Notes application that could talk with Apple's. I'm not 
holding out much hope on the cross talk. But I do find it odd that Android phones I've used don't seem to 
have their own standalone note-taking app (the Galaxy S3, with S Memo that can sync to Google Docs 
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or Evernote, is a nice exception, in my experience).
What I'd like to see even more is Outlook on the Mac getting a way to talk to iCloud to sync notes 
created within Outlook. And contacts. And calendars. These are things Outlook for Windows can do 
(though it can't do Notes).

Finally, though I love the new functionality of Notes sync, I was greatly disappointed that there seemed 
to be no way to sync existing notes marked as "On My iPhone" or "On My iPad" to flow into iCloud.
As best I can tell, notes that have never been associated with a cloud-based account can't be added or 
moved to one.
If you want these notes to flow into the cloud, it seems to be a tedious process of copying them 
individually from a device-specific account to a cloud-based one.

Sync iOS with Mountain Lion
iCloud is built into OS X Mountain Lion from the ground up. Between 
syncing documents from Preview and Pages to contacts and calendars, 
iCloud is handling it all. As such, you'll want to make sure your iOS 
device is taking advantage of as much of the cloud as possible. This 
great walkthrough will show you how easy it is to be achieved.
How to sync your iPhone, iPad with Mountain Lion via iCloud

With the introduction of iCloud -- Apple's service for storing your data and content online rather than on 
your devices -- you can now sync all of your stuff wirelessly between your Mac, iPhone, and iPad. This is 
great for adding things like appointments into your calendar as they will instantly appear on all of the 
Apple gizmos you're using.
If you haven't set up iCloud on your devices, it's easy to do, but you have to ensure you're using the same 
Apple ID on all your gadgets. By default, my iPhone was set to the account I use for the App Store, 
which is different from my iCloud account.
To enable iCloud in Mountain Lion, the latest edition of Apple's Mac OS X, go to System Preferences 
and log in with the Apple ID you want to use. I choose to enable all of the services here, such as Find My 
Mac and Photo Stream, but you can just check the ones that you'll use if you prefer (see image below).
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Finally, to make sure everything syncs with your iOS device, you'll have to enable the same options. To 
do this, go to Settings > iCloud on your iPhone or iPad and check that your account is the same as the one 
on your Mac and that the same services have been enabled.

 
On iOS 6, you can sync data from apps such as Mail and Calendar, but all of your open tabs will sync 
over to the new Safari as well if you're using Mountain Lion. This is a really useful feature if you're 
browsing at home and have to rush out, but want to continue what you were doing online.
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http://appadvice.com/applists/show/apps-for-cooking-and-dining-in

Grocery iQ
by Coupons.com
Before you head to the store, write the perfect grocery list with Grocery 
IQ. The app is free, universal, and you can create and edit your list 
online from any computer. With features like barcode scanning, list 
sharing, and integrated coupons, you'll shop smarter than ever.

Fooducate - Healthy Food Diet & Nutrition 
Scanner
by Fooducate, Ltd.
Staying healthy by choosing the right things to eat isn't always easy. 
With Fooducate, you can easily scan your food at the market to help 
you choose the healthiest of items. The app gives you all the nutritional 
information you need to stay on track and eat healthily.
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Alarmed ~ Reminders, Timers, Alarm Clock
by Yoctoville

It's time to get everything packed in the oven and hot on the stove. Hosting a 
party? If so, you're probably in the middle of making several courses at once 
and need to keep track of all their cooking times. This app keeps all of your 
timers in one place. With one-time notifications, custom alerts, and over 80 
unique alarms, Alarmed is a valuable kitchen aid.

Locavore
by Hevva Corp.

Eating seasonally helps your wallet and your tastebuds. If you eat according 
to the seasons, you will eat produce at its freshest. This app finds what's 
seasonal in your area and tell you what's in season or what's soon going to be 
out of season. Then, after seeing what's in season, Locavore will show you 
where your favorite farmer's markets are.

Hello Vino - Wine Recommendations
by Drive Thru Interactive

Why not get some drinking wine while you're out buying some cooking 
wine? Indulge your inner wino with some vino. Pick the perfect bottle for 
any meal, occasion, or palette. Hello Vino has the most comprehensive wine 
database out there, recognizes labels, and lets you save your favorites for 
future reference.
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Bonus Findings....!  For the iPhone or Camera Buff...


